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Getting Started with TINA-TI™

This quick-start user's guide presents an overview of TINA-TI™, a powerful circuit design and simulation
tool. TINA-TI is ideal for designing, testing, and troubleshooting a broad variety of basic and advanced
circuits, including complex architectures, without any node or number of device limitations. This document
is intended to help new TINA-TI users start creating circuit simulations using the fundamental features of
TINA-TI software in the shortest possible time.
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Texas Instruments has teamed up with DesignSoft, Inc. to provide our customers with TINA-TI, a powerful
circuit simulation tool that is well-suited for simulating analog and switched-mode power supply (SMPS)
circuits. The tool is ideal for helping designers and engineers to develop and test circuit ideas.

TI selected the TINA™ simulation software over other SPICE-based simulators for its combination of
powerful analysis capabilities, simple and intuitive graphics-based interface, and ease of use, allowing you
to be up and running in minimal time. If you are familiar with another SPICE simulator, adapting to TINA-TI
should be an easy and straighforward transition. Although TINA-TI is a limited version of more powerful
DesignSoft simulation products, it easily handles surprisingly complex circuits.

Texas Instruments does not warrant or support any DesignSoft product. TINA-TI is a software program
developed by both TI and DesignSoft. For more information about DesignSoft, visit the DesignSoft website
at www.designsoftware.com.

TINA-TI is a trademark of Texas Instruments and DesignSoft, Inc.
TINA is a trademark of DesignSoft, Inc.
Windows is a registered trademark of Microsoft Corporation.
All other trademarks are the property of their respective owners.
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2 Schematic Editor
Schematic Editor www.ti.com

You can download TINA-TI from the TINA-TI webpage, as shown in Figure 1. Alternatively, it is available
through the TI home page at www.ti.com; enter TINA in the keyword search field to display a summary of
TINA-TI related information. Selecting the first result takes you to the TINA-TI webpage.

Figure 1. Downloading TINA-TI

The minimum hardware and software requirements for the currently released TINA-TI version are:
• IBM PC-compatible computer running Microsoft Windows® 98/ME/NT/2000/XP
• Pentium or equivalent processor
• 64MB of RAM
• Hard disk drive with at least 100MB free space
• Mouse
• VGA adapter card and monitor
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3 Building a Circuit with TINA-TI

www.ti.com Building a Circuit with TINA-TI

Once the software is downloaded to your system, select the program through the Windows Start menu or
click on the TINA-TI icon on your desktop that was created during the installation. The first screen appears
as shown in Figure 2.

Figure 2. TINA-TI Schematic Editor Display

Figure 2 shows the schematic editor layout. The empty workspace on the sheet is the design window
where you build the test circuit. Below the Schematic Editor title bar is an operational menu row with
selections such as file operations, analytical operations, test and measurement equipment selection, etc.
Located just below the menu row is a row of icons associated with different file and TINA tasks. The final
row of icons allows you to select a specific component group. These component groups contain basic
passive components, semiconductors, and even sophisticated device macromodels. These groups are
accessed to build the circuit schematic.

To illustrate how easy it is to use TINA-TI, we will build an analog circuit and demonstrate some of the
circuit analysis capabilities.

For this example, a high-output, 1kHz sine wave oscillator circuit is selected. A search through a circuit
application handbook provides a number of op amp-based designs. We will build and simulate a
Wien-bridge oscillator with amplitude stabilization using the software. A Texas Instruments' OPA743 12V
CMOS op amp is selected for the circuit application. This amplifier is well-suited for this design, and
provides very good dc and ac performance. It operates with supplies of 3.5V to 12V; our example requires
±5V (10V).
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Building a Circuit with TINA-TI www.ti.com

Select the Spice Macros tab (see Figure 3, step 1) and then the op amp symbol (step 2) to access the
OPA743 macromodel. When the op amp model list appears, scroll down and click on the OPA743 (step
3). Then click OK. The op amp symbol appears in the circuit workspace. With the mouse, drag the symbol
into position (step 4). It is locked into position on the circuit workspace by clicking the left mouse button.

Figure 3. Building a Circuit with TINA-TI

Other op amp models may be selected using the Insert->Macro... menu. Additionally, macros and a wide
variety of pre-built analog and SMPS circuits can be accessed through the Insert menu.
(Insert->Macro...TinaTI_7.0->Examples).
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3.1 Adding Passive and Active Components
www.ti.com Building a Circuit with TINA-TI

Component selection is easily accomplished by clicking on a component group from the lower row of tabs:
Basic, Switches, Meters, and so forth. These tabs provide a wide variety of passive components, sources,
meters, relays, semiconductors, and the previously-mentioned circuit macros. Click on the schematic
symbol for a particular component and drag it into position in the circuit workspace. A left mouse button
click locks it into place.

In our example, shown in Figure 4, we select a resistor from the Basic tab group (step 1 and step 2), then
position it next to the op amp symbol. TINA-TI designates this resistor as R1. The initial value of R1 is
1kΩ, but this value can be changed as needed. A double-click with the left mouse button on the R1
symbol produces the associated component table (step 3).

Figure 4. Active and Passive Component Selection

The resistor value and other component characteristics may be altered by selecting the individual
parameter boxes and changing the respective values. Select the component parameter box and highlight
the value you wish to change. Enter a new value by typing over the value that is shown. In Figure 4, for
example, the value for R1 has been changed from 1k to 4.7k for this circuit. Once you have finished
setting the parameters, click OK to close the table. Similar parametric tables are available for passive
devices, sources, semiconductors, and other component types.

A handy component that is displayed in the Basic group is the jumper, as shown in Figure 4. It looks like a
sideways letter T. The jumper may be used to connect similar, related circuit functions such as V+, V–, or
any other circuit point that has multiple connections. Using the jumper reduces wiring clutter. Note that
common jumpers must be labeled with the same label name for TINA-TI to connect them together.
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3.2 Arranging and Wiring Components

4 Analysis Capabilities

Analysis Capabilities www.ti.com

Once all components are selected and properly positioned, they can be wired together. Each component
has nodes where circuit connections are needed. TINA displays these nodes with a small red x. (The x
looks more like two small lines at the wiring node than the alpha character.) Wiring components to each
other is easily done by placing the mouse pointer over a node connection and holding the left mouse
button down. A wire is drawn as the mouse is moved along the circuit space grid. Release the mouse
button when the wire reaches the intended end connection point. Figure 5 illustrates the TINA-TI software
wiring function.

Figure 5. Wiring Components Together

The wiring function also may be accessed from the Insert menu, or the icon that looks like a small pencil.

When the circuit schematic entry is complete, the circuit is nearly ready for simulation. The analysis
process begins by selecting the Analysis menu. A list of different types of analyses—such as ac, dc,
transient, or noise—appears. Highlight any one of these evaluations to access additional options and
selections.

The first option under the Analysis menu is an Error Rules Check (ERC). Selecting this feature runs this
check on the circuit; a pop-up window then lists any circuit errors. If an error is listed in the window,
clicking on that error line highlights the error point in the schematic. The error window also lists other types
of circuit errors that are found during the analysis.
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4.1 DC Analysis

www.ti.com Analysis Capabilities

Even if the ERC is not selected, TINA automatically performs a check at the start of a simulation.

Upon selecting one type of analysis to perform, another window appears that displays different setting
selections that are associated with that particular analysis. Nominal settings are initially provided; these
parameters may be set as needed for the desired output.

Once all of the selections are made, click OK to begin the analysis. The first analysis performed on a
circuit is generally a dc analysis. This test provides a reality check so that normal dc operating conditions
can be verified. The TINA-TI DC Analysis function can be set to calculate nodal voltages, provide a table
of dc voltage and current results, generate a dc sweep of the circuit, or perform a temperature analysis.
The temperature analysis works in combination with the Analysis > Mode > temperature-stepping
selections.

Follow these steps (illustrated in Figure 6) to perform a dc analysis.
1. Click on the Analysis menu.
2. Select DC Analysis.
3. Click on Table of DC Results. The Voltages/Currents table appears.
4. Use the mouse pointer as a probe to test the circuit nodes.

The probed node and measured value are displayed in red in the Voltages/Currents table, as shown in
Figure 6.

Figure 6. DC Analysis with Voltages/Currents Table Displayed
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4.2 Transient Analysis
Analysis Capabilities www.ti.com

Sophisticated ac frequency and time domain simulations may also be performed. Use the Analysis
function to access the different choices. A traditional ac transfer characteristic plot of gain and phase
versus frequency may be selected, as well as transient, Fourier or noise analyses. The example shown in
Figure 7 is a transient analysis performed on the example Wien-bridge oscillator circuit. The simulation
transient analysis result is also shown in Figure 7. It illustrates the Wien-bridge oscillator startup and
steady-state performance. The display in the actual window may be edited with axis labeling, scales,
background grid color, and so forth, all set as desired by the individual user.

Follow these steps (marked in Figure 7) to perform a transient analysis.
1. Click on the Analysis menu.
2. Select Transient.
3. The Transient Analysis dialog box appears. Enter start and end times, and other parameters as

desired.
4. Click OK to run the analysis.

Figure 7. Additional TINA Analysis Capabilities
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5 Test and Measurement
www.ti.com Test and Measurement

The TINA-TI software generates post-simulation results in tables and plots, depending on the type of
analysis performed. Additionally, the software can be placed in a pseudo-real-time simulation mode where
virtual instruments can be used to observe the output(s) while the circuit is operating.

For example, Figure 8 shows a virtual oscilloscope that is used to observe the steady-state output of the
Wien-bridge oscillator circuit. In the same way, a virtual signal analyzer can be used together with an
amplifier circuit so that the harmonic performance of a simulation can be observed. To access the virtual
oscilloscope, select T&M (step 1 in Figure 8), and then Oscilloscope (step 2). Place the cursor at the
output of the simulated circuit, and adjust the controls in the virtual oscilloscope dialog box as needed
(step 3).

The T&M selection options also include a virtual ac/dc multimeter, function generator, and an X-Y
recorder. The function generator may be adjusted in combination with a virtual oscilloscope or analyzer.

Figure 8. Virtual Instrumentation Testing
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6 Additional Assistance
Additional Assistance www.ti.com

TINA-TI has many more features that can be explored. As you become more comfortable with the
simulation software, you will be able to take advantage of these capabilities to build circuits more rapidly,
perform more sophisticated simulations, and optimize the output information for a variety of needs.

The software also offers on-screen contextual help, and displays mouse-over descriptions for many icons
and areas of the workspace, as shown in Figure 9. If you need additional assistance with a particular
analysis, or help with setting the active component parameters, detailed help documentation is available.
Click on the Help menu to access information associated with circuit analysis, active components, and so
forth. Further assistance for specific TINA-TI application simulations is available by contacting your local TI
technical representative.

Figure 9. Contextual Help in TINA-TI

Note: Texas Instruments does not offer support for TINA software. Contact DesignSoft if you have
questions or need assistance with general TINA software issues.
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IMPORTANT NOTICE
Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, modifications, enhancements, improvements,
and other changes to its products and services at any time and to discontinue any product or service without notice. Customers should
obtain the latest relevant information before placing orders and should verify that such information is current and complete. All products are
sold subject to TI’s terms and conditions of sale supplied at the time of order acknowledgment.
TI warrants performance of its hardware products to the specifications applicable at the time of sale in accordance with TI’s standard
warranty. Testing and other quality control techniques are used to the extent TI deems necessary to support this warranty. Except where
mandated by government requirements, testing of all parameters of each product is not necessarily performed.
TI assumes no liability for applications assistance or customer product design. Customers are responsible for their products and
applications using TI components. To minimize the risks associated with customer products and applications, customers should provide
adequate design and operating safeguards.
TI does not warrant or represent that any license, either express or implied, is granted under any TI patent right, copyright, mask work right,
or other TI intellectual property right relating to any combination, machine, or process in which TI products or services are used. Information
published by TI regarding third-party products or services does not constitute a license from TI to use such products or services or a
warranty or endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual
property of the third party, or a license from TI under the patents or other intellectual property of TI.
Reproduction of TI information in TI data books or data sheets is permissible only if reproduction is without alteration and is accompanied
by all associated warranties, conditions, limitations, and notices. Reproduction of this information with alteration is an unfair and deceptive
business practice. TI is not responsible or liable for such altered documentation. Information of third parties may be subject to additional
restrictions.
Resale of TI products or services with statements different from or beyond the parameters stated by TI for that product or service voids all
express and any implied warranties for the associated TI product or service and is an unfair and deceptive business practice. TI is not
responsible or liable for any such statements.
TI products are not authorized for use in safety-critical applications (such as life support) where a failure of the TI product would reasonably
be expected to cause severe personal injury or death, unless officers of the parties have executed an agreement specifically governing
such use. Buyers represent that they have all necessary expertise in the safety and regulatory ramifications of their applications, and
acknowledge and agree that they are solely responsible for all legal, regulatory and safety-related requirements concerning their products
and any use of TI products in such safety-critical applications, notwithstanding any applications-related information or support that may be
provided by TI. Further, Buyers must fully indemnify TI and its representatives against any damages arising out of the use of TI products in
such safety-critical applications.
TI products are neither designed nor intended for use in military/aerospace applications or environments unless the TI products are
specifically designated by TI as military-grade or "enhanced plastic." Only products designated by TI as military-grade meet military
specifications. Buyers acknowledge and agree that any such use of TI products which TI has not designated as military-grade is solely at
the Buyer's risk, and that they are solely responsible for compliance with all legal and regulatory requirements in connection with such use.
TI products are neither designed nor intended for use in automotive applications or environments unless the specific TI products are
designated by TI as compliant with ISO/TS 16949 requirements. Buyers acknowledge and agree that, if they use any non-designated
products in automotive applications, TI will not be responsible for any failure to meet such requirements.
Following are URLs where you can obtain information on other Texas Instruments products and application solutions:
Products Applications
Amplifiers amplifier.ti.com Audio www.ti.com/audio
Data Converters dataconverter.ti.com Automotive www.ti.com/automotive
DSP dsp.ti.com Broadband www.ti.com/broadband
Clocks and Timers www.ti.com/clocks Digital Control www.ti.com/digitalcontrol
Interface interface.ti.com Medical www.ti.com/medical
Logic logic.ti.com Military www.ti.com/military
Power Mgmt power.ti.com Optical Networking www.ti.com/opticalnetwork
Microcontrollers microcontroller.ti.com Security www.ti.com/security
RFID www.ti-rfid.com Telephony www.ti.com/telephony
RF/IF and ZigBee® Solutions www.ti.com/lprf Video & Imaging www.ti.com/video

Wireless www.ti.com/wireless

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
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